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User’s Guide for OceanFax 5.0

1. FAXVIEW GUIDE

1.1 FaxView Login and Exit

1.1.1 FaxView Client Login

& Oceanfax Fax\View

-

Follow the below steps to log in FaxView Client:

Open the OceanFax FaxView. To open the program, click Start > All Programs > OceanFax
FaxView or double click the shortcut icon E at the desktop.

Log in. If it is your first time to log in, you need to input server information (Format: Server IP
Address: Port, the default port is 80 or leave it blank), User ID and Password. Click Log in to
access the FaxView interface.

“Server “option: The login interface will store the server information, including the Server IP and
Port Number, which you input when you logged in before. Select the server in the drop-down list
of servers.

“Remember password “option: If a user ticks this option, once he enters his password, the
system will remember. When he logs in next time, the password will be automatically entered.
Otherwise, he needs to retype the password every time you log in.

OcegﬁFax
| Server: 144.214.5.190 CITLS
: User ID: NAMSADMIN

Password:

Remember Password

Domain User Login

# LOGIN ) CANCEL

FAXVIEW

2009 OceanX Technology Co.,Ltd. All Rights Reserved
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User’s Guide for OceanFax 5.0

1.1.2 WebFax Client

e OceanFax provide a simplify web client for user to manage their fax, user can follow below to
access WebFax client.

1. Ininternet browser (support IE and Chrome)

2. Type http://144.214.5.190/WebFax in address field.

3. Below screen will show.

4. Input user name and password as same as the step to login to FaxView client.

5. Other operation, user can reference to the FaxView instruction in this guide.

D nir/ 1442145190 weblax/ Account/LogintRenumii= O « G

File Edit View Favorites Took Help * Eomen -

b = [ a v Page= Satey+ Tools+ i@+ [N (0

. oc=nnFax
IW' = OceanFax account
! s
["JRemember me
Send and Receive Fax [ Ipomain User
via Web Anytime, Anywhere
Log in
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D it MAZMSAINWebT s P - G| 2 oceanrax x .
File Edit View Favorites Tools Help % SHcomwen v Bis
e B - 2 me o Page~ Satew~ Tools~ @ 5 0H
= i Welcome NAMSADMIN | Logout

Mla22 22X H &8N s v [l

New fax Reply ReSend Forward Defete Edit  View History Download Release Move Refresh Custom

R | | ut | Recipients | rmd Subfect | status | Send time Company Name | EmailAddress | JobType
2 fax file from 8/3/2017
5 My faxes add fax:223 Naw Fax 10:07:02 '
{ fa file from Bf3f2017
bl Inbox 213 fax:222 T e 10:04:03
3 Outbox | fax file from B3f2017
i fax:221 Mew Fax 9:59:08
Il Trash
2 21 & 244, oK 8/o/2017
X Archive Fax 7561 9:54:09
. sl g A 8/3/2017
4 My folder @ - 220 3444 o 9:53:03 ¥
= = : 2 fax file from 8/3/2017
{5 Options - 21 fax:218 i P 9:51:40
= ;
i Send Profile s Biafa017
lg 218 & +85 oK oo
s User Info Option
3 7/3/2017
214 X | Lo 17:41:46
#a Change Password =
1x| B 344; K ghivx i}
L4} Phoneboak 17:25:35
185
a4 i o 2
228! fth

Notes:

WebFax client is only a simplify version of FaxView, not all the FaxView function included in WebFax
client. Such as Report, Auto Forward setting, Auto Print setting, etc.

1.1.3 FaxView Exit

1. Exit FaxView Client: Click Exit on menu bar or click top right x.

2. Exit FaxView Web Client: Click Exit on menu bar or close IE.
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2.2 FaxView Overview

FaxView is the main interface where users send, receive and manage their faxes.

It is divided into four sections including menu bar, fax list, left panel and status bar.

g DosanFay Faelagw il
P e Manu Bar U
- - a = b Ty
oo g 2R LN rB b ST
Piew fax | Bty Fowed Amile il Moer HBefprd Dewmie Bl Ay Aol Comdew  Adleass Susperd Besne Approve Hsiory AeSesh Exdi
EE—
- 11 DooumeHD Stabs Savts réomston Fax b asgms Sipiect a0 Tews | Bling Code e
" =\l o
£ wbowin) [ I P S N I T T R
[y cutoan 3 . o 0 1 Administ,., F13... a
Y Trash
Left Panel
A M Mg #|
4 Dutors x| Fax List
Defegaies |
== —I
|
|
Cureniikesr AdmnETator  Server Deanfae Yewonr 10 Status Bar E

2.2.1 Menu Bar

Users can perform various operations on all the inbound and outbound faxes by clicking the buttons in
menu bar.

2.2.1.1 FaxTab

OceanFax FaxView supports ribbon interface by listing main operation buttons on Fax Tab in menu bar.

e e g 2R e DS wS T

!!New fax| Reply Forward Route Out  Move ReSend Delete Edit  Wiew  Split Combine Release Suspend Resume Approve History Print Refresh | Exit

- - x

el i ) T &

¢ New Fax: Launch a new fax form

* Reply: Directly reply to an inbound fax, with no need to input recipients to avoid any mistake
due to manual input

e Forward: Forward a fax to other users and keep one copy

* Route: Pass a fax to other users with no copy left

*  Out: Forward a fax to external fax numbers

¢ Move: Move faxes to different folders according to fax type, importance, the related projects or
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by habit for storage

Resend: Turn an outbound fax as a new fax’s attachment and send it again and allow to resend
multiple faxes at one time

Delete: Clean up outdated or junk faxes periodically to keep FaxView a clean interface and the
deleted faxes will disappear from the fax list in FaxView and yet still be stored in Trash folder.

Edit: Modify some information of an inbound fax to update some of its properties.
View: View faxes by implementing OceanFax’s original fax viewer - Tif Viewer

Split: Split a multiple-page fax into multiple individual faxes according to requirements. The fax
created by split will be regard as a new fax.

Combine: Combine two or above selected whole faxes or part of faxes to a new fax for
transmission or easy management and review. The fax created by combining the existing faxes is
regarded as a new fax. Its subject will be “Combine from faxes: xxx, xxx” (xxx as the document ID
of the faxes”). All the faxes to be combined must be inbound or outbound faxes at the same
time.

Release: This option is designed for the faxes needs preview before sending. A user can preview
a fax that is held for preview by using this option and click this button again to release the fax for
delivery after preview.

Suspend: When a user needs to put the transmission of some faxes in higher priority, he can
suspend outgoing faxes using this option. If a fax is suspended, no user is allowed to perform any
operations on it. Only when a fax is in the status of “Waiting for Creating Cover Sheet”, “Held for
Preview”, “Waiting for Approval” or “Waiting for Sending”, can a user preforms this operation.

Resume: When a fax is suspended, a user can cancel the suspension by using this option and
goes on perform other operations on the fax.

Priority Setting: When a user needs to put the transmission of a fax in higher priority, he can
suspend it first and then set its priority by using this option.

Approve: When a user creates a new fax, if he ticks at Need approval and selects an approver,
the fax status will be “Waiting for approval”. Only after the approver approves the fax, can the
fax be transmitted.

Print: To print highlight fax to printer, support multiple faxes selection.

Refresh: FaxView automatically refreshes for every 5 minutes. Users are also allowed to click
Refresh in Fax Tab to refresh the fax list manually and set up automatically refresh interval by
click the down arrow under Refresh button.

b5

t Refresh  Exit

W W

Refresh Interval 1

History: Users are allowed to view the record of the execution of each step on each fax, including
transmission, view, conversion, approval, and etc.

Search: OceanFax supports quick Search, advanced Search and fax data filter

Preview: Preview the content without opening the fax images. Only when the status of a fax is
“successfully converted” or after, can a user previews it (except the status of “Waiting for
generating a cover sheet” or “Waiting for conversion”)
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e Sorting: Faxes can be sorted in the fax list based on the sender's identification or other fields.
FaxView will remember users’ sorting habits and save their personalized settings for fax sorting.

e Exit: Exit FaxView without log out. Next time Faxview can be start without prompt for username
and password. To fully logout faxview, click on the down arrow under Exit button and select
Logout

Notes:

Users can also perform the above-mentioned operations by right mouse click.

2.2.1.2 Options Tab

Options tab lists all the options designed for system settings, including system information.
* Phonebook: Add, remove and edit contacts. Import and export Phonebooks.
* User info Option: Edit user information.
* Send Profile: Edit send options, including setting default cover sheet.
* Change password: Change FaxView’s login password.
*  Archive Fax: View the archived faxes.

e Associated group of users: Manage group member of the Associated group which manage by
login user.

* New: Create a new folder in left panel.
e Edit: Edit folder information.
¢ Delete: Delete folders in left Panel.

My OceanFax FaxView

Fax Options Report Style
== fr—] — - — — -~ ey -
. z o & = | i) [ = —
DB PRLOS @ +2&
Phonebook User Info Send Profile Change Archive Stamps Reading Delegates  Assodated Mew Edit Delete

Option Password  Fax Pane = group of users

2.2.1.3 Style Tab

Users can change the interface style by clicking a below button in Style Tab in the menu bar.

Fax Options Report Style

B O - B

Black Blue Caramel Maginary Lillan MoneyTwins The Asphalt = Office Office  Office 2007  Office Office || Xmas 2008 Valentine Summer Pumpkin
World 2007 Blue 2007 Black Silver 2007 Green 2007 Pink Blue 2008
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2.2.2 FaxList

In fax list, users can view all the inbound and outbound faxes, as well as their properties, including
document ID, status, subject, pages, date, and etc. Besides, user scan sort faxes by any item of properties
for quick search and easy reading.

I My fanws I x

[t | DoumentiD v | Satus | Swtus aformaton _:Fq. P A T { Omesse |Tie  EngC.. | CabwiD -

Read Fax £ 3 w0 @ o EAHES 2 Adewnsty st 2010 AN
ez § = 29600002 2 Admarests ter 210.

:’:"“"':E 191 9 oK 29543455 1 Administistor 201 295455
ik »no @ o 29600002 1| W teen Adninstystce 010,
Bbiad 3389 New Fax 1 Sphit hom fax: 3349 Administiator 2m
Fax 1388 New Fax 1 Sphbt from faw I4T  Admersstsator n

2 207 9 oK 29543455 1 Admaratsator 201... 29543455

A 2t @ i POE L DAEE 1 A b1 1 POE 4 DAEE

2.2.3 Left Panel

Users can select the folders listed in the left panel.

Fax: Allow users to manage their own fax folders

| Fax Manager

| 4% Fax A

UE o Need approval: Only when the users have Group
[3) Inbox(33) Administrative Operate Permission or Administrative
i3 outbox Operate Permission, will the folder appear. The folder
L] Trash contains all the faxes need to be approved.

e All Faxes: This folder is only visible to the system
administrator. The system administrator can view all the
faxes of the users, except super user’, by clicking All Fax
at Fax Manager in the left. The system administrator can
perform view, edit and delete operations on these faxes.

e Group Fax: This folder is only visible to the group

~ administrator. The group administrator can view all the
.j Fax manager & faxes of the group members, except super user’, by

clicking Group Fax at Fax Manager in the left. The group
administrator can perform view, edit and delete

= Need approval faxes(0)

= All Faxes .
operations on these faxes.
(S oas 2 .
> Options Options
Phonebook

e  Phonebook: Phonebook Management
£ User info option
W send Profie e Userinfo option: Change User Information

Change password e Send Profile: Change Send default Setting

¥

®  Archive Fax e Change Password: Change OceanFax Login Password

Delegates
e  Archive Fax: View Archived Fax

|
| Delegates ES
' = e Delegates: Invoke the delegates interface

Otherusers |

Delegates: View the fax folder of delegators
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2.2.4 Status Bar

Status Bar is at the bottom of FaxView. It provides the current user’s basic information, including current
user, the connected server, OceanFax Version and the fax’s total number in the selected folder.

I e — 1 s |

2.2.5 Help

To launch Help, click top right icon &3 or click F1.

2.3 Fax Transmission_

Fax transmission is a key feature that FaxView provides. In FaxView, users can deliver electronic
documents efficiently and apply rich functions in fax transmission by advanced settings to meet their
diversified needs.

2.3.1 Quick Transmission

Fax transmission by OceanFax is quite fast and simple. Only if users have a recipient’s fax number and a
document, can they send a fax.

1. Click New Fax in Fax Tab.

2. Inthe “Basic Information” Tag, Input a fax number in “Fax No.” field.
3. Upload a document.

4. Click Send.

Fax information x

Fax No.: 23021234 [ Need Approval

Cover: No cover sheet -

Upload Attachment

[ send = = Cancel
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2.3.2 Complete Transmission and Send Email by FaxView.

OceanFax supports cover sheet and different types of attachments.
Uses can send a fax with more information included by applying complete transmission.

Also user could also have a backup fax number for a fax, just in case if the primary fax number is not
able to call to, OceanFax will use Backup Fax no. to send the fax.

If OceanFax was configured to send email with mail server, user also can insert the email address in
Email Address field to send the fax image through email too.

Fax information x

J Basic Information || Send Option || Other Option |

Redpients
Mame: |m| [T Meed Preview
Fax Mo.: 23454345 [T Meed Approval
Company:
Email Address: Peter, Chan@ABCCompany,com
Backup Fax Mo.: 23454346 |

Subject And Cover

Subject:
Cover: Mo cover sheet -

Cover Content:

Attachments

e e e - Lremp PriceList. xisx | Upload |

| Send | | cancel |

After submit the new fax and new email, the FaxView will show as separate record as below:-

Page | 9
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My Faxes

Job Type Status ¥ Status information Fax No. Email Address . Subject
v
y: | waoro0r || sendemot ondaxint. |
steven@email.lab 1 send email and fax int... .

Fax would be show the icon as E

Email would be show the icon as ]

Notes:
For Backup Fax No feature:-
1. Must input Fax No. and cannot only input backup fax no. for send fax

2. Backup Fax no will use for send fax after OceanFax use Fax no to send fax but failed completely
(failed also after retry)

For Send email through FaxView feature:-

1. This feature only available when OceanFax was configured for send email, please check with your
system administrator.

2. If OceanFax system already enabled DSN feature, after the email was success to receipt and OceanFax
received the return DSN was success sent, then the email status will change to OK, otherwise
show Fail;

3. If OceanFax system did not enable the DSN feature, all the email will only show “send success” is
mean the email was send to relay mail server success only. But OceanFax will not know if relay mail
server was send failed to receipt.

2.3.2.1 Cover Sheet

An outbound fax with subject and cover sheet can provides more information. Users can select a cover
sheet in the drop-down list of covers under Subject and cover in Basic information tab.

A cover sheet can include the below information:
e Recipient: Recipient’s name, fax number and company name
e Sender: Sender’s name, phone number, fax number and company name
e Subject

e Cover Content

Page | 10
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Fax information x

| Basic Information [send Option || Other Option |

Redcipients
Name: Peter Chan | Phonebook | "I Need Preview
Fax No.: 23454345 ("I Need Approval
Company: ABC Company | =
Email Address: Peter.Chan@ABCCompany.com
Backup Fax No.: 23454346
Subject And Cover
Subject: New Price List
Cover: CoverSheet1 =
Cover Content: Dear Mr. Chan, A
Attached please find the price list for your reference. v
Attachments
Selected Attacments TR | [ (i
C:\Temp'Pricelist2. xlsx [ G;‘
K
| Send | | Cancel |

2.3.2.2 Fax Attachment

OceanFax supports different formats of attachments, including doc, excel, pdf, txt, jpg, tif and etc. Users
can upload multiple attachments at one time, as well as manage them by clicking right buttons.

e Move Up: Move the selected attachment up.
e Move Down: Move the selected attachment down.
e Delete: Remove the selected attachment.

e Preview: View the selected attachment.
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Attachments

Selcted Attt I 4 | |

C:\Temp'PriceList2.xlsx

.4
X
K

Fax information

Basic Information | Send Option || Other Option

Users can change attachment sequence by using Move Up or Move Down option.

2.3.3 Mass Fax

Mass Fax refers to sending a fax to more than one recipient at one time. OceanFax FaxView provides
two different ways to process mass fax.

Fax Settings
Priarity: Mormal-priority Enable Header
Fax Resolution: Fine (200DPT) [T]Enable Footer
[F] Cheap Time: 00:00:00
[ Delay Send 28/1/2016 00:00:00 L =t
Add Barcode
Water mark: Mo WaterMark
Retry: o Interval: 3
Sender Information
Mame: Administrator
Fax Mo.: 0
Tel:
Company:
| Send | Cancel |
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2.3.3.1 Phonebook

If users want to send mass fax and all the recipients’ fax numbers are in phonebook, users can select the
recipients directly from phonebook.

Follow the below steps to select contracts from a phone book.

1. Click New Fax in menu bar and click Phonebook in “Basic Information” tag.

2. Select a phonebook in the drop-down list of phonebooks in From field.

My Phonebook: The phonebook created by users.

Shared Phonebook: Applied together with the drop-down list of users. Users can select the
phonebooks shared by the defined users.

Company Phonebook: Contain all the contacts with the Checkboxes next to “Company
Phonebook” selected while they are newly created.

Groups: Contacts can be classified to different groups by selecting the Checkbox next to

“Group”.

3. Select the contacts in the “select recipient” list. Users can select multiple contacts by pressing
the SHIFT key and then clicking adjacent contacts, or by pressing the CTRL key and then clicking
contacts that are not next to each other.

Add recipients x|
From: My PhoneBook - Group: .
Select recipient
Full name Fax no. l Company name
? —_—
21236547 Amy Holding Ltd. | Select
Paul Chan Paul Ltd.
PPP Company
No Company
4 - .
Selected recipients
| oadd |
| | Tom Leung 29999999 T&TCo 5
Delete
| |Paul chan 56789576 Paul Ltd | |
| |taiManchan 99988877 ™Co | Clear |
YAYA T 5577AR99 FTO p
| fals I Cancsl

4. Click Select to add the selected contacts the list of Selected recipients.

5. Previewing the recipient list under Selected recipients and click Ok to confirm.

6. Click Send.
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Notes:
1. Click Select All to select all the contacts of a phonebook as recipients.

2. If users select the Checkbox next to “Send Email”, the message will be delivered to recipients by
email and fax at the same time. If not, it will only be delivered by fax.

2.3.3.2 Add Fax Recipients Temporarily
If a recipient is not in phonebooks, follow the below steps to create a new contact to the recipient list.
1. Click New Fax in menu bar and click Phonebook in “Basic Information” tag.
2. Click Add next to the “Selected Recipient” list to create a new contact.
3. Input the new contact’s information.
4

Click Ok to add the recipient temporally.

Add recipients =
From: My PhoneBook. - Group: ]
Select recipient
Full name [ Fax no. Company name Tel number -
7 1
Amy Wong 21236547 Amy Holding Ltd. Select |
| |Tina cheung 24562134 T&TCo. Selectal |
Tom Lemq T&TCo.
Candy Lo PPP Company
| tommychung  gassoses No Company
| Tai Man Chan 99988877 TM Co.
Wrwvare e feo | [N
-
1 — »
Selected recipients
Full name | Fax no. | Company name | telnumber |
| Paul Chan 56789876 Paul Ltd. //"—
YAYA To 55776599 ETO 1
Clear |
|. Ok I. Cancel

2.3.3.3 Select by Group

Users can also select recipients by groups.
Follow the below steps to select recipients by groups:
1. Click New -> Fax information-> Phone book .
2. Select the Checkbox next to “Group” to show all the phonebooks.

3. Select a group in the “select recipient” list and click Select and all the recipients in the group are
then added to the “selected recipients “list.

4. Repeat step 3 to add another group.
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2.3.4.1 Priority Setting

When a user needs to put the transmission of a fax in higher priority, he can suspend it first and then set
its priority by using this option. There are four choices for priority setting, including Highest, High
priority, Normal priority and Low priority.

Therefore, users can re-arrange the fax transmission sequence to let some faxes being transmitted first
and delay the others.

Notes:

Fax information x

sensoprn TR

Select priority |
Priority: Normal ' [¥| Enable Header

tority =

Fax Resolution: S L Iﬁmﬁ"’w
Normal-priority |

(| Cheap Time: High-priority

= Highest

[T Delay Send

Retry: 35

Name: Administrator
Fax No.: 0
Tel:

It is recommended to select High priority option to send an important fax in an emergency and select
Low priority option for mass fax or large size files transfer.

2.3.4.2 Fax Resolution Setting

Users can control the quality of fax image by using this option. The default setting is Fine (200DPI).
When users send faxes in large quantity, they can set fax resolution to Standard (100DPI) to accelerate
the delivery speed. However, the image quality will be reduced.

Fax information x

sentovn (S

Normal-priority

Fax Resolution: Fine (200DPI)

— Standard (100DPI)

F :

e T Fire(000PD |

[] Delay Send

Retry: g

Name: Administrator
Fax No.: 0

Tel:
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2.3.4.3 Delay Send Setting

Uses can set the delivery time by using this option instead of sending faxes immediately after being
prepared.

It can meet the requirements of some recipients who only want to receive faxes in specific time or live in
a different time zone.
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x

Fax information
Send oo
Fax Settings
Priority: Normal-priority . et
R Fine (2000°0) | Specified Date and Time J
] Cheap Time: 00:00:00 /
[¥|Delay Send! 19/6/2013  ~ 00:00:00 -
Retry: 33 Interval: 3
Sender Information
Name: Administrator

Notes:

When the delivery time set for Delay send is earlier than or at the same time with the current system

time, the fax will be delivered immediately.

2.3.4.4 Auto Resend Setting

If a fax fails to be sent due to busy line or line error, OceanFax will automatically resend the fax.

Users can set the properties of auto resend by using this option.

Fax information

oo nfmaion LT

Other Option

Fax Settings
Priority: Normal-priority - [V Enable Header
Fax Resolution: Fine (2000PI) - Enable Footer
[] Cheap Time: 00:00:00 2
(| Delay Send| 19/6/2013 -] [00:00:00
Retry: z 5 Interval: 3

]

e Retry: Set how many times in total to resend.

¢ Interval : Set the interval every time the fax is resent

2.3.4.5 Custom CSID

Users can set the sender’s fax number that displays on the fax (CSID) by using this option.
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Fax information x

Basic Information [BSSte kel Other Option

Priority: Normal-priority - V| Enable Header
Fax Resolution; Fine (2000PT) - []Enable Footer
[ClCheapTime:  00:00:00 :]

(] Delay Send |19/6/2013 - | |00:00:00 |

Retry: Es Interval: EE

Sender Information

Name: Administrator |
| Faxto- 29663300 ||
Tel: | i
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2.4 Fax Reception

Users are allowed to view and manage inbound faxes in the FaxView interface.

When faxes come in, they will be automatically distributed to different users according to the system
settings. When users access FaxView, they can view all their inbound faxes in Inbox folder (See below
picture), including those sent from external fax numbers and sent, transferred, routed from internal
users. All the inbound faxes can be replied to, forwarded and routed to the internal users and the
external fax numbers.

h} ‘ My fhves - Py Fas Failios S
£ Dptions Roport yle "‘_.'
E 9 F .- > A {1y &
22 A2 EE B DS F
BaSerd] || Dnite Eds e SR Combeew | Daleasa Apgroww Ftiry CDafresd Ext
Number of Unread faxes
-"r.'ﬁl-ﬁ x
| [ rov faes : r-
TE N ' Y T T I T
) outbo | BE] 29 o : A.. 2010{ 0-1000
7 Trash ML » 9 o 1 A, 2000/ 01000
| {® 2 @ o | Unread fax - BOLD I A, 00 0100
L% 199 ox 1 A 2010.. 01000
WE] 179 ox 1 A 2000 01000
L2 1“9 ox 3 A 2010 0-1000
| | & 129 oc 1 A 2mD 0-1000
k] wWe o 1 A. 2000 01000

2.5 Fax Operation
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2.5.1 View

Users can view faxes with OceanFax’s original fax viewer - Tif Viewer under MyFax.

AT AT LU AR L Ceman DY emer

L Y W LR S ]

" rem T i

There are below four default folders:

My Fax: contains all inbound and outbound faxes (Trash not included)
Inbox: contains all inbound faxes
Outbox: contains all outbound faxes

Trash: contains all deleted faxes

There is two way to view the fax. One way is to double click the fax users want to view in fax list.
The other way is to select the fax you want to view and then click View in Fax tab of menu bar.

Users can also create new folders to facilitate classifying and filing faxes.

2.5.2 Print

Users can perform this operation to print a fax while highlight a fax in fax list.
Follow the below steps to print a fax without open it:-

1. Highlight a fax in fax list.

2. Click Print Tool Bar.

3. Select a printer.

4. Click Print.
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2.5.3 Sorting

Faxes can be sorted in the fax list based on the sender's identification or other fields. FaxView will
remember users’ sorting habits and save their personalized settings for fax sorting.

Select the field for sorting. The triangular icon will appear. The fax records show in ascending order with

the apex upward or descending order with the apex downward.

The following graphic shows faxes sorted with ascending order by “Document No.”:

J My Faxes ’ x

[Docume...l;] ] Istatusmforma... ]Fax... ‘ iSubject |0wner lTime | ] |‘

v =
2 9 ’ OK 123 1222 Administr... 2010/09/13 16:...

& 109 oK 01000 1 Administr... 2010709713 16:...

| R 19 oK 123 1222 Administr... 2010/09/13 16:...

| 2 12 @ oK 0-1000 1 Administr... 2010/09/13 16:...

| s 139 oK 23459... 3 Price List Administr... 2010/09/16 14:___

WEX 14 @ oK 0-1000 3 Administr... 2010709716 14:...

2.5.4 Print

Highlight any fax in fax list, click Print button to print. Support multiple faxes selection.
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ﬂ |

27644338 Administrator

Select Printer
o @ Microsoft XPS Document Writer @ Oceanfax Content PS 91
i % OceanFax Content PS 1 89 Oceanfax Content PS 92
| {#5) OceanFax Content PS 2 i OceanFax CoverSheet PS

[>

Ot

ol e

1874 - @ NK Ak

2.5.5 Refresh

FaxView automatically refreshes for every 5 minutes. Users are also allowed to click Refresh in Fax Tab
to refresh the fax list manually.

@_- e MG Faves ,: SOE; i —ﬁ“—'m;i
N x| optons  Repot stk ul

:r*s 22X qk-n e vgaln

New fax || Reply Forward Route Out  Move ReSend || Delete Edt  View  Spit Combine || Release Approve History] Refresh]| Exit |

.‘.. )| i ) 2 5

User can also change the automatically refresh interval by click down arrow under Refresh
Button.
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19 r 5

t Refresh  Exit

v

== Refresh Interval 154

2.5.6 Search

2.5.6.1 Quick Search

Users can perform this operation to search faxes quickly and accurately by entering a key word into any
field in fax list.

There are two ways for quick search. The first method is by entering keyword in list boxes of fields, the
second method is by selecting criteria in drop-down menu.

Entering keyword in list boxes of fields
Example: follow the below step to search all the faxes with the fax number starting with 23:

Enter 23 in the list box of “Fax No.” field and then all the faxes with the fax number starting with
23 are listed in fax list.

l My Faxes | x
[oocume... N [ ; [smtus informa... | Fax no. I ]Suhject 10wne: | Time [ [ . ‘
? i23 |
2 139 oK 23459876 3 Price L... Adminis... 2010/09/16 1__.
| 2 31 ' Held for Preview 23456789,,,,... 2 NewPri... Administr.., 2010/09/20 16:38
BE 32 ) Waiting for ap... 23456789 1123 Adminis... 2010709720 1...

Select criteria in drop-down menu.
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2.5.6.2 Advanced Search

For certain complex searches, users might want more control over the results that they see. They can
perform Advanced Search operation to set up self-defined filters by single condition search or multi-
condition search, making searches more precise and getting more useful.

Single condition search

Example: Follow the below steps to search all the faxes fails in delivery:

1. Put the mouse on “Status Information” field and then Icon ¥ appears at the right side. Click the
Icon.

2. Click Custom in the drop-down menu.

‘.. ‘Statusinformation aNeaynn ] la,
(Blanks)
329 oK (Mon blanks)
QK
| ML Unexpected fax card error
360 @ oK r
40 @ ox B L] — i

3. In Custom AutoFilter dialogic box, select does not equal in the drop-down list and enter OK in
the field and then Click OK.

Customn AutoFiter b 4

Show rows where:

Skatus infFormation

does not equal - oK
@and  COr

{Select an operator) - {Enter a walue)

| ok | | Cancel |

4. The following graphic shows the search results:
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] My Faxes |
Il:m:mm | |5tmrformatm A'[Fa... | ]swjer.t
g
e | 834 @ Unexpected fax card ... 2511... 1
e | 835 @ Unexpected fax card ... 2511... 1
PE: 836 @ Unexpectedfax carderror  2511... 1 Testing
PE 837 @ Unexpectedfaxcarderror 2511... 1
| |2 838 @ Unexpectedfax carderror  2511... 1

Multi-condition search

Example:

Follow the below steps to search the faxes from page 3 to page 5:

User’s Guide for OceanFax 5.0

1. Put the mouse on “Pages” field and then Icon ¥ appears at the right side. Click the icon.

2. Click Custom in the drop-down menu.

Pages

(Blanks)

1
2
28

{Custom) i

{Non blanks)

Hiuo
H...

3. Set the filter as the above graphic and then click OK.

Customn AutoFilter

Show rows where:

Pages

|is greater than or equal to

@ And

o

|is less than or equal to

Cancel |

4. The following graphic shows the search results:

JMyFaxesl

| DocumentID

|Statl.|shformatlon

l Pages

’1}

.l'.

2

2

31 Q
139

s1 @
52 @
53 @
54 @

Held for Preview
DK

_--H_-

OK

N NN
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2.5.6.3 Fax Data Filter

OceanFax FaxView provided an easy to use but very powerful filtering function. It supported unlimited
rules for a filtering. Even it is very powerful, but you do not need to learn any complex filtering statement,
you can complete a complex filter with a simple few step.

For example, if you want to find out all fax with the following condition: Fax Number begins with 2345
and have only have 1 page; or the faxes Fax Number is 29876543 and the fax sent or receive before
10ct2010.

1. Right Click any field name in the fax list and then click Filter editor.

l DocumentID ‘ . ‘ Shabie infarmatinn [ panac
= {7 2L Sort Ascending
— - 29 @ ( 21 Sort Descending
3 30Q c
| £ 31 %y H = Group By This Column
__\'- 32 ' ¥V = GroupBy Box
BE: 339 C Remove This Column
_J’. 349 £ Column Chooser
= BP T = penrr
) @ c
— 3 7P ¢ W Filter Editor
™ o 39 1 Best Fit (all columns)
H 20 @ T

2. Click the logical keyword And to select different logical keyword. In this example, we use the
default value “And”.

& Fiter Editor ¥

1 D And
@ Or
@ Mot &And
@ Mot Or

=, add Condition
=* add Group

| [o]4 | | Cancel | | Apphy |

3. Click the + next to the logical syntax “And”, to add a new condition.

&% Filter Editor x

| [o]4 | | Cancel | | Apply |

4. Click the field in blue colour. We can change which field use for the condition. We use fax no. In

Page | 27



User’s Guide for OceanFax 5.0

this example.

7 Filter Editer x

Begins with True

Company name
Custom code 2

Custom codel
Document1D
Fax no.

File name

Folder | oK | Cancel | | Apphy |

Tk I0

5. Click the condition syntax in green colour, to select using what condition for filtering. We use

“Begins with” in this example.

E5 Filter Editar x

= Equals

# Does not equal

> Is greater than

2 Is greater than or equal to
< Islessthan

4% Isless than or equal ko
£ Is between

3£ Is not between

abe Conkains

ach Dioes nok conkain

[ab Begins with | | Cancel
hiel Frarls with -

| Apply

6. Click “Enter a value” to input the value.

[Fax no.] Begins withi

7. We using “2345” in this example

and ¢
+[Fax no.] Begins with 2345

8. The first condition has been finish. You can delete the condition with the “x” a the end of the

condition.

and ©
[Fax no.] Begins with | 2345 D

9. Using the step 3-6 to add the other condition — only 1 page in the fax.

And ©
[Fax no.] Begins with 2345
[Pages] Equalsé}é .

10. Start to add Or rule. Click Add Group to add a new group of rule.
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- @ And 345
@@ Or
@ Mot And
@ Mot Or

=, Add Condition
=* add Group
# Clear all

11. Click the new “And” symbol, and change it to “or”.

And ©
[Fax no.] Begins with 2345
[Pages] Equals 1 ¢
iand €
@ And ins with
@ Or
@D Not And
@ Not Or

12. Use the same method as step 3-6 to add the conditions under the secound group.

=

Ly Filter Editor

And ©
[Fax no.] Begins with 2345 ¢
[Pages] Equals 1
Or €
[Fax no.] Equals 29876543

x Concel | [épely

x

13. After all condition added, click Apply.

14. Click OK. The fax list will only show the fax’s fax no. begin with 2345 and contain only 1page. Or
the fax’s fax no. is 29876543 and the fax sent or receive before 1 Oct, 2010.

Notes: Logical Keywords:

1. “And” —Filter records that fulfill all condition under the “And” tree.

Example:
And

Example:

Filter the records that the caller ID between 100 and 200

“Or” — Filter records that fulfill any one condition under the “or” tree.
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[Caller 1D] Is between 50 and 100
[Caller ID] Is between 200 andz

User’s Guide for OceanFax 5.0

Filter the records that Caller ID is “between 50 and 100” or “between 200 and 250”.

3. “Not And” —Show all records except the record fulfill all condition under the “Not And” tree.

Example:

Not And

[Caller ID] Is greater than 100
[Caller 1D] Is less thani200;

Filter the records except the caller ID between 100 and 200.

4. “Not Or” — Show all records except the record fulfill any one condition under the “Not Or” tree.

Example:

Mot Or

[Caller ID] Is between 10 and 50
[Caller 1D] Is between 100 andi150,

Filter the records except the caller ID “between 10 and 50” or “between 100 and 150”

5. “Add Condition” — Add a new condition under the tree

6. “Add Group” — Add a new group. Can make some group of condition with different logical

keyword (“And”, “or”, “Not And” and “Not Or”).

Condition Keywords

Il

Equals
Does not equal
Is greater than

AWV VL

Is less than

i

& Is between

3£ Is not between
abc Contains

acb Does not contain
(3o Begins with

blc] Ends with

axc Is like

azc Is not like

O Isblank

@ Is not blank
oo Is any of

wo Is none of

Is greater than or equal to

Is less than or equal to

2.5.7 Move

Users can perform this operation to classify faxes into different folders by type, importance, project or

other criteria.

Follow the below steps to move a fax to the destination folder:
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1. Select a fax and click Move in the Fax Menu.

2.

@ Fax Options Report Style

Mew Fax

F1

e

SRR A = )

Reply Forward Route Out | Move Resend |

e

Select the destination folder and click OK.

Moveltem x

Mowe ikems selected to folder
(=} My Faxes
[z+ Inbox(54)

& Diema

| oK | | Cancel |

Notes: Drag-and-drop function: Click a fax and drop it to the destination folder.

2.5.8 Delete

Users can clean up outdated or junk faxes periodically to keep FaxView a clean interface. The deleted
faxes will disappear from the fax list in FaxView and yet still be stored in Trash folder.

1.

esarf e | Myfees »
o — NN N -
Bl rocon K .
= [ 0w | |& 79 ok 1 0 Ad. 20M00U24.. B
G ote: RE a9 o 1 0 Ad_ 2010/09724.. 0
el QL) 49 o 1 0 Ad. 20M0/0%/24. 0
59 ok i 0 Ad_ 201070924 O
| =2 529 oK 2 0 Ad_ 20100724 0
& 59 ok 2 0 Ad_ 2000/0%/24.. 0
E 5 57§ ox 2 o Ad. . 20010/00/24.. o
* 589 Ok 2 0 Ad 200009724 ©
A fenages rY 609 oK i 0 Ad_ 201009724 ©
B Need appeovall) et 29 ok 1 0 Ad_ 20000924, 0
Al Faces L &7 9 ok 1 0 Ad_ 2010700724 0
: 4| |s 9 x 1 0 Ad 2MOMWA. 0
i WL 779 ok 1 0 Ad 20008724 0
L -~ e . " .t VY -

Select the fax you want to delete. You can select multiple faxes by pressing the SHIFT key and
then clicking adjacent faxes, or by pressing the CTRL key and then clicking faxes that are not next

to each other.

Click Delete in the Fax Menu.

Page | 31



User’s Guide for OceanFax 5.0

(g

2232 g 2K L

New fax || Reply Forward Route  Out Move ReSend |||Delete] Edit

Fax Options Repaort Style

5| &)

. My faxes - OceanFax FaxVi

@_4\ SO L

View Split  Combine

Ma

3. Click OK to confirm.

Notes: Users can also directly click Delete on their keyboards to delete a selected fax. The faxes

are under transmission cannot be deleted.

2.5.9 Edit

Users can modify some information of an inbound fax to update some of its properties, including

Subject, Sender information etc. Follow the below steps to edit a fax:

1. Select a fax and click Edit in Fax Menu.

ax Options Report Style

Q - My faxes - QceanfFax Faxyie
h_. 2

al P Pt

Mew fax || Reply Forward Route  Out Move ReSend || Delete | Edit

i) |

‘.\ LN W -

View Split Combine |

&)

2. Update the properties and then click OK to confirm.

Notes: Only inbound faxes can be edited.

2.5.10 Combine

Users can perform this option to combine two or above selected whole faxes or part of faxes to a new
fax for transmission or easy management and review. The fax created by combining the existing faxes is
regarded as a new fax and can be routed and forwarded. Its subject will be “Combine from faxes: xxx,
xxx” (xxx as the document ID of the faxes”). All the faxes to be combined must be inbound or outbound

faxes at the same time.

1. Select the faxes you want to combine. You can select multiple faxes by pressing the SHIFT key
and then clicking adjacent faxes, or by pressing the CTRL key and then clicking faxes that are not

next to each other.

2. Click Combine in fax menu bar.

3. Adjust the sequence of the fax by using L button.
4. Select the page of each fax (By default, All page selected)

Cambine pages

(1Al page

@) Range From: 2 Ta

4
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&
5. Click * to preview the fax and Click X to remove the fax is not needed.
6. Click OK to combine.

Notes: The combined fax will be kept in “My Faxes” folder; the Status is “New Fax”. And the
Subject should be “Combine from faxes: xxx, xxx” (xxx as the document ID of the faxes”)

2.5.11 Split

Users can perform this option to split a multiple-page fax into multiple individual faxes according to
requirements. The fax created by split will be regard as a new fax.

Follow the below steps to split a fax:
1. Select the fax you want to split.
2. Click Split on Fax Menu.

u.n

3. Input the condition in the dialog box of split windows. You can use “;” to split few fax at same
time.

For example: 1-2;1,3,5;4-6

Three new faxes will be created in this example. The first one contains page 1 to 2, the second
one contains page 1, 3 and 5, and the third one contains page 4 to 6.

Spiit x
Enter a range of pages from this fax to be used for the new faxes.

use a hyphen to specify ranges ,a comma to separated multiple pages and a
semicolon to create faxes.

Example:1-2;1,3,5;4-6

Create three faxes,the first contains the 1,2,3 page;the second
contains 1,3,5 page and the third contains 2,3,4,5,6 page.

Total no. of pages of this fax: 10
1-2;1,3,5;4-6|

View
¥/ Keep original fax

OK Cancel

4. Click OK to split.
Notes:

If the Checkbox next to “Keep Original Fax” is selected, the fax’s original copy will be kept after splitting.
Otherwise, the original copy will be deleted after splitting.

The new fax created by splitting will be kept in “My Faxes” folder and in “New Fax” status. Its subject
will be “Split from faxes: xxx” (xxx as the document ID of the original faxes”).

2.5.12 Reply

Users can perform this option to directly reply to an inbound fax, with no need to input recipients to
avoid any mistake due to manual input. Follow the below steps to reply an inbound fax:
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el S

Select an inbound fax you want to reply.
Click Reply on the fax menu.
Input fax content and attach fax images.

Click Send.

2.5.13 Forward (to Internal Users)

Users can perform this option to forward a fax to other OceanFax Users with the original copy kept after
forwarding. Follow the below steps to forward a fax:

1. Select a fax you want to forward.
2. Click Forward in Fax Menu.
3. Select users and click Add to add them to the selected user list.
4. Click OK to confirm.
Sedect user
Salect user
|Username | Frstn...  |Lastna.. |Grow |Rote1d | Telnumber |4
ot }
| Admiristrator  Administr... 1000
>  — | — | pi— | —
|Yes
j(xemx
_lSh
| Ocoanadmin L
\[W_jl | Remove |
Esmctedm
User name Lastname |Frstna... |Grouwp Route ID Tel number
Ok | Cancel
2.5.14 Route
Users can perform this option to pass a fax to other users with no copy left. Follow the below steps to
rout a fax:
1. Select the fax you want to route.
2. Click Route in Fax Menu.
3. Select users and click Add to add to the selected user list.
4. Click OK to confirm.
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2.5.15 Out (to External Fax Numbers)

Users can perform this option to forward a fax to external fax numbers. Follow the below steps to
forward a fax to an external number:

1. Select the fax you want to forward out.
2. Click Out on Fax Menu.

3. Input the recipients, including recipient name, fax number and company name or select
recipients from a phone book (Refer to 2.3.3.1 phonebook).

4. Click Send.

2.5.16 Resend

Users can perform this option to turn an outbound fax as a new fax’s attachment and send it to the
previous recipients again. They are allowed to resend multiple faxes at one time. This operation is
suitable for a user to meet a recipient’s request to resend the same fax that the user has sent to him
before, or resend the faxes which are failed to be sent to the recipients due to busy fax lines. Follow the
below steps to resend a fax:

1. Select an outbound fax you want to resend.
2. Click Resend on Fax Menu.

3. Click OK.

2.5.17 History

Users are allowed to view the record of the execution of each step on each fax, including transmission,
view, conversion, approval, and etc.

History x
Operate time Operate type Operater
2010-10-21 10:04:35 Yiew Adrministrator

View by:Administrator
Viewed by: Administrator
2010-10-21 10:04:02 Wiew Administrator
View by:Administrator
Viewed by:Administrator
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2.5.18 Right Mouse Click

Users can also perform the operations mentioned above by right click.

2.5.19 Heavy Fax Data Loading

OceanFax FaxView supports the below way to load heavy fax data.

When users log in FaxView each time, only the latest 1,000 faxes will be loaded to the fax list. If they
want to view the earlier faxes, they need to pull the scrollbar to load another 1,000 faxes each time.

2.6 TiffViewer

Tiffviewer is a powerfully viewer to allow you to modify, annotate and manage your Fax document.

Below section will instruction common function and some special function in Tiffviewer which did not
mentioned in other section within this document.
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| [n201703080953337376CEDC0.BF-Ooean Tiff Viewer

b Sumpontosipeses * da ) T-of B -2 ©

o From o853 34T T6T Cwm TG0 0020 1 Pugmal

<RS2 342 TG0

2.6.1 Save

Users can perform this operation to save a fax while opening it with Tif Viewer.
Follow the below steps to save a fax:

1. Click File > Save As in Tool Bar.

2. Input file path, file name (the default file format is Tif or Pdf)

3. Click Save.

2.6.2 Normal view and Page break view

For some incoming fax, when the every page size are normal size (e.g. A4, A3, Letter), we can use
normal view to view it. However, when some incoming fax page are longer than a normal size
(e.g. a page with doble highest of A4), then we can use Page break view to view it or to split the
current fax page into two parts in left and right or top and bottom, so users can print different
sections of the fax page. Follow the below steps to split a fax window:

1. Open afax in Tif viewer.
2. Click File/Page break preview.

3. Drag-select on section and then Click Print by Fax Printer.
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& con20140709181035043AE06D
IZW Fax Page Zoom Help

| L_j Open Ctrl+Q i #3

l Save As ro [

D Normal view |

.....

Page break preview

=4 Print
(=3 Page break print

Exit

2.6.3 Print

Users can perform this operation to print a fax while opening it with image viewer.

Follow the below steps to print a fax through Tifviewer:-
5.
6.
7.

Click File = Print Tool Bar.
Select a printer.

Click Print.

ﬁ con201407 02181035043 AE06D
I§8 Fax. Page Zoom Help
= | Open Ctrl+ 0 t

Save s = |

] Mormal view

_____ Page break preview

IEi Erint K

= Page break print

Exat

L

2.6.4 Print page break

Users can perform this operation to print a fax while the received fax have some page longer than a A4

size, to avoid the printout will be reside to a A4 page size.

Follow the below steps to print a fax with page break function:-

1.
2.
3.

Click File = Print Page Break in Tool Bar.

Select a printer.

Click Print.
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& con20140709181035043AE06D¢
7 Open Ctrl+0 H
Save As = [

| Normal view |

Page break preview

{=§ Print
(=) Page break print

]

X .

Exit

[ " Compam

2.6.5 Paint on Fax

Allow us to modify the Fax image, by Pen tool, Line tool, Circle tool, Rectangle tool and Eraser.
1. Click on Paint icon button on the Tiffviewer’s tool bar
2. Modify your fax image
3. When finish, click Save button in Paint window
4

Remember click Save to Server icon in Tiffviewer to upload the fax image after modified.

¥
Ei

le Fax Page Zoom Help

O 3% - e i e=s[ b dz 4 1ofs B Stampontoalipages [ & -0 T - & 3 :
| 7551 |1
ol Paint

o Save ) Exit

N/ 2014 3H 26 9:45 Active 882162807551
O o : : : _

s®| i ; ‘= ' '

[ |
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2.6.6 Attachment Fax image to Email directly

To attachment opened Fax image to an Email directly, we can click on Email icon in Tiffviewer’s
tool bar, select PDF format or Tif format.

# CconZ0140709181035043AE0609.6F-0ceany Tiff Viewer

File Fax Page Zoom Help

iRAEB LA DBDISEES

@39% - 2.1 M[ Shodie A | 1of5 = Stamp onto-all pages B & = & T - 4
. 2014 3 26 45 Active BE21SZBOTSH o

Then the email client will popup with Fax image attachment.

EH S & + & = Fax file. - Message (HTML)

FILE MESSAGE IMSERT OPTIOMS FORMAT TEXT REVIEW

To... |
=1

|
Send

Subject |Faxfi|e.

Aftached ‘ifaxﬁmanbuﬂhn.pdfmﬁm

2.6.7 Add text and text stamp

We can add any text word on a Fax, also we can save any text word as a stamp for us to re-use it.

1. Click on Text icon on the Tiffviewer’s tool bar.

2. Inthe input text dialog box, input any text you want to print on the Fax image
3. Click Add to Favorites if you want to reuse it later as a stamp.
4

Click OK want to finish the text input.
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File Fax Page Zoom Help
iRA2=ALAOBSEE S
PR 9% 23 u[ 2h s 4 10f5 | p [ Stampontoallpages [ & ~ "v 4

204 3

Stamp
"This is a sample Text

i

6. Remember click on Save to Server icon button on Tiffviewer’s tool bar to upload modified
Fax image to save.

7. Toreuse saved Text stamp, you can click on the down arrow beside the Text icon.

THr 0@-w

Starnp with Txt

Approved!

Mot approve
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Notice: When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text,
etc will also copy and paste to all the page at the same position.

Stamp onto all pages ¥ & -~ &) T -

2.6.8 Freehand draw tool

In Tiffviewer, there have an Free hand draw tool allow user to draw and paste on Fax image.
1. Click on Clock icon on the Tiffviewer’s tool bar.

2. Then paste the timestamp on the fax you want.

3. Click Save to server button to upload the modified Fax image to server.

File Fax Page JZoom Help
iR AESALABDBSE I
@m@f“[ dhﬂh'ﬂﬂb-ﬁampontoallpagﬁ.x & T+

24 3H 26 245 Active BE21B2BOTSH

D [y

A OO —[/]tine- | @]

4. Paste the draw on the place you want on the Fax image

5. Remember to click Save to server button to upload the modified fax image to server
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File Fax Page Zoom Help

R WACLAROR: | O] bR e
PO 39% L@ I 0-[ abodie A 10fs b [} Stamp onto all pages [
2014 38 28 45 Active B62162807551 Gk -

N LA
\é\

Notice: When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text,
etc will also copy and paste to all the page at the same position.

Stamp onto all pages & DT~

2.6.9 Time stamp tool
In Tiffviewer, there have an time stamp tool allow user to stamp timecrop on fax.
Click on Pen icon on the Tiffviewer’s tool bar.

Draw everything you want and click on the green Tick to finish.

foom Help

ﬁ E @1' ShoAe 4 1of5 b [[[] Stamp onto all pages [ ‘-—@
4 37 26 @45 .ﬂctlwz 862162807551 m '

| N\ s e

Notice: When Stamp onto all pages checkbox are ticked. Then the same draw, stamp, text,
etc will also copy and paste to all the page at the same position.

Stamp onto all pages & - T~

2.7 Folder Management

2.7.1 Create Folder
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Users are allowed to create and define new folders for classifying the different types of faxes.

Follow the below steps to create a new folder:
1. Select the “Options” tag in the menu bar.

2. Click New in the “Options” menu.

& -
- Fax Options Style
= =3 — R N - ol L
. = - or
[ & e (p &
|Phonebook User info Send Profile Change Archive || New | Edt  Delete
{ option password  Fax

[
|
&)

]

3. Input the folder name, and select the Parent Folder.
Note:
Parent folder mean the new folder is under which folder.

For example, if users select “Inbox”, the new folder will under the Inbox.

e folder x Example:
Folder name; {Demno Fas
I:-Z Demo Fax
o -3 outbox

@ Trash

4. Click OK to confirm.

2.7.2 Edit Folder

Follow the below steps to edit a folder:

1. Click the Edit in the Options Menu.

: -
Fax Options Style

b & & B & %L

‘Phonebook User info Send Profile  Change Archive || Mew | Edit |Delete |

option password Fax
F

5
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2. In the “Folder Info”, select the folder you want to modify and then input the folder name in the
“folder name” field and select the new parent folder.

Foldar o *

=) Mty Fames
(=} Trbax(2)

Osthseos
Trash

Foldar rarme: D et

Parer Folder: Tnbo(2)

3. Click OK to confirm.

2.7.3 Delete Folder

Users can delete the useless folders in their OceanFax accounts. Before deleting a folder, users must
move or delete all the faxes in the folder. Follow the below steps to delete a folder:

1. Select the folder you want to delete.
2. Select the “Options” tag in the menu bar.

3. Click Delete in Options menu.

(::) s My fa
Fax Options Style

| = 3 o & || ¥ aw

Phonebook User info Send Profile Change Archive || New Edit | Delete
option password Fax ||
‘ 5| &

4. Click OK to confirm.

OceanFax Help 'E'

\:;y A you sure to delete this folder?

L ] J [ Cancel

Notes:

The default Inbox, Sent and Trash folders are created by FaxView system, which cannot be edited
and deleted.
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2.9 Phonebook

2.9.1 View Phonebook

Users can not only create contacts or contact groups in phonebooks for their own use, but also share
them to other Users.

There are two ways to open the Phonebook interface:

Option 1: Click Phonebook button on Options Menu.

Option 2: Click Phonebook under “Options” on Left Panel.

2.9.2 Phonebook Search

Users can perform this operation to search contacts. The way is the same as “Advanced Search” of fax
(Refer to Chapter 2.5.6.2). Users can also apply the search function when they create a new fax:

] @ 5

| 4% Fax

|_‘g Fax manager

|—§; . Dptions
Phonebook

%5 User info option

Send Profile

Change password

¥, Archive Fax

II

O Fax Options Report

- »

Fax information

o

Style

~AllD 4

| Basi information | Send option || other option |

| Recipients =
Fax no.: Add recipients
Company: From: My PhoneBook. Group:
| subject and cover Select recipient
Subject: F Full name Fax no. Company name Tel number
Cover: i i
Cover content: Peter Chan 29876543 ABC Company
Paul Chan 56769876 Paul Ltd.
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2.9.3 New Phonebook

2.9.4.1 New Group

Users can classify contacts to multi-layer groups in phonebooks. Follow the below steps to add a new
group:

1. Click New and New Group in phonebook interface.

u M Fremstecl - OrsirFar Farties e
Fe Wirs Nogewt ke '_"l

= % PR %9
Lo e o aynd Vol Saum ‘!_’!-l - L& | {alwin
et e Sl Mrebooh x
- - +n--- £ pitn | W ot | g #:mﬂl

<O T - -
{1 se_ JI

Akl Erarmbionk o eetry

o rane [T

Parerit Al

b Fos maneges o Fenyt For ey Crily

B ewd approval)

HFaes

2. Input the group information including Group name, Parent and Remark.

3. Click Save.
Example:
=} ALL
- HR Dept
=} Admin Dept
. Sales Admin Unit

2.9.4.2 New Contact

Follow the below steps to add a new contact:
1. Click New in a phonebook, and then input the new contact’s information.

2. |If the Checkbox next to “Shared Phonebook” is selected, the new contact will be shared with all
the users. (Refer to 2.3.3.1 Phonebook).

3. If the Checkbox next to “Company Phonebook” is selected, the new contact will be added to the
company phonebook. The contact can be found in the company phonebook while creating a
new fax. Only administrators or users have administrative permission can add contacts to
company phonebook.
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Preboot | x
: r - ~
i g tew- |/ update | P Oelete ____-lnwt.L*‘ExportH
=y | e -
+~ HR Dept L
B — petr Lt s chon
- Sales Admin Unit
Display name: Peter Chan Nickname: Peter
Growp: IT Unit Ernail peter@abc.com
Fax no.: 23456789 City: Hong Kong
d Tel.: 23456788 Province:
Mobile: ZIP:
Company: ABC Company Country: Hong Kong
Title: 1T Manager
Address: o Remark: =
Save Back v

2.9.5 Edit Phonebook

2.9.5.1 Edit Group

Follow the below steps to edit a group:

1.

2
3.
4

Open a phonebook.

Select the group you want to edit.

Rename the group or/and change the parent.

Click Save.

2.9.5.2 Edit Contact

Follow the below steps to edit a contact:

1.

2
3.
4

Open a phonebook.

Select the contact you want to edit.

Revise the contact’s information.

Click Save.
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2.9.6 Delete Phonebook Record

2.9.6.1 Delete Group

To delete a group, users must delete all the contacts in it first. Follow the below steps to delete a group:

1.
2.

Select an empty group you want to delete.

Click Delete in the phonebook toolbar.

My Faxes JI Prombookl

gl m s [ | _
| g News| 4 Update xoelete’; ﬁ_.lmt‘{ﬁlixwtﬁ_

2.9.6.2 Delete Contact

Follow the below steps to delete a contact:

1.
2.

Select a contact you want to delete.

Click Delete in the phonebook toolbar.

2.9.7 Import Phonebook

Follow the below steps to import a phonebook:

1.

Click Import in the phonebook toolbar.

| My Faxes |I Phonebook |

sl | .
: --TllNew-J 4 Update !IXDelete .'Import|

r’.‘ Export

Click View in the Import interface, and find the txt or CSV file that contains the phonebook
records. Users can select Replace, Rename or Do Not import the duplicate record and then

select which group the record will save to.

Click the Check-box next to “shared phonebook” or “Company Phonebook” if needed and click

Next to continue.
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Import x

File name:
(1 Enable replace duplicate items when import

(Enable create duplicate items
(@) Disable duplicate import

Save to group:
1ALL -

[”|Shared Phonebook

[”| Company Phonebook

4. Select the field to be imported (Generally no changes needed) and click Next to continue.
5. Preview which records will be imported and then click Finish to start importing.

Notes: OceanFax determines the duplicate records by the full name of the records.

2.9.8 Export Phonebook

Follow the below steps to export a phonebook:

1. Click Export in the phonebook toolbar.

[ My faxes | Phonebook |
el

2. Click View in the export interface to select the location the file will be exported.

£ voise

3. Click Next and select the fields to export.
4. Click Finish to start exporting.

2.9.9 Share Phonebook

Refer to 2.8.4.2 New Contact.
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2.9.10 Refresh Phonebook

After user import new phonebook, FaxView might not able to refresh asap. User could click on Refresh
button to refresh the phonebook list to show all the latest update records.

Phonebook

+I'\.Iew- é’ Update x DeleteI @Refresh | . Import | [ﬁ" Expurt-

FuII ame Cnmpan';.f Grnup name Tltle Fax Mo, 11

'='J|.

2.10 User Profile

2.10.1 Send Profile

Customize the default setting of sending new fax. Refer 2.3.5 Advanced Feature for options ‘meanings.
Follow the below steps to change the sending profile (Default setting of sending fax):

1. Click Send Profile in Options Menu.

2. Change the setting.

3. Click Save.
Option x
Cover Sheet: Ma cover sheet - [T Preview send
Resolution: Fine (200DPI) - [[]Need Approval
Priority: Mormal-priority - Enable Header
Retry: o [7] Add footline
Interval: 30
[T Delay Send 00:00:00 : [] Smart resume
[ Cheap Time: 00:00:00 :
Watermark: Mo Watermark -

| H save | | ¥ cancel
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2.10.2 UserInformation

Some features require user information access for turning it to sender’s profile and fax header, so users
must keep their user information complete and updated.

Follow the below steps to update user information:
1. Click User Information in the Options Menu.

2. Update the information.

3. Click Save.
Option x
First name: Demo User Last name:
Fax nao.: 22223333
Fax gk 3333
Tel.: 22223334
Maobile: 99587766
Ernail: demouser@oceanfa, com
Language: English {United States) -
Compary: OceanFax
Address: 1111, Demo Siky, Hong Kong|
Zip code;
H save ®  Cancel
Notes:

It is recommended to input the information in English to facilitate Header setting.

2.10.3 Change Login Password

Follow the below steps to change login password:
1. Click Change Password in Options Menu.
2. Input old and new password respectively.

3. Click OK to save the new password.
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2.19 Interface Style

OceanFax supports twelve interface styles. Users can change their interface style by clicking the below

icons.

5

Black

Fax Options Report Style

B O -

Blue Caramel iMaginary Liian MoneyTwins

The Asphalt ||  Office Office Office Office
World 2007 Black 2007 Blue 2007 Green 2007 Pink
=

Office 2007 |
Silver
I}
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2.20 Multi-language

Users can change their user interface language by following the below steps to set the user interface
language:

1.

2
3.
4

Click User Information in the Options Menu.

Select your language in the drop-down list of languages, including English and other 8 languages.

Click Save.

Restart FaxView to start the new interface.

Option
First narne: Dermno User Last narne:
Fax no.: 22223333
Fax ext.: 3333
Tel.: 22223334
Maobile: D9557 766
Ermnail: demouser@oceanfax. com
ILanguage: English {United States)
Deutsch -
Campary: English {United States)
Espafiol A
Address: Frangais 3
Ha#58
Zip code: Al
tharithie ) RHETE) -
| H Save | | * Cancel
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3. PRINT TO FAX

This function enables the way of fax transmission by converting a fax image into a tif file and then faxing
it out as a fax attachment. For example, users can fax a document in word, excel, txt, pdf or jpg format
out quickly by using this option after open it. Follow the below steps to print to fax:

1. Open adoc file, click Files and then click Print.

L!; - ! Dogumaent] - Microsofy
- Hame Tnsert Page Layout Raferences Mailings At View
i S
Primt
B s s f=3
“y Copeen: 1
; O
i Prrt
3 Clote
Info Printer Title
OceanFuc Fax Printes
-y -
Recent - Ruvdy
New Printer Prooertes -
Settings
bred Tesung D
e 4 Pret Al Page: -

2. Select OceanFax Fax Printer in Printer options, adjust Printer property if needed.
3. Click Print and then the FaxView “Login” dialog appears.
4. Enter the login username and password.
5. Input the fax information including fax number in the "Fax Information” dialog box.
6. Click Send.
__Fa_x infbrmatiqn
| Basic information |["Send option || Other option |
Recipients
MName: Peter Chan | Phonebook |
Fax no.: 29693204 [ Need preview
Company: ABC Computer Company [ need approval
Subject and cover
Subject: Testing Print to fax
Cover: |CoverSheet1 [v]
Cover content: |
Attachments
Selected attachments: CHilserstuser|AppDataiLocali TemplOceanFaxiFaxPri ﬁ. [ Upload |
4
X
(<] " | A
[ Send | ( Cancel |
Notes:

Print to Fax supports automatic login, which means login once with no need to re-login again next time.
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*** End of document ***
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